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About the
Documentation

This manual is part of a set of Xerox EX7750 documentation that includes the
following manuals for users and system administrators. Most are available as Acrobat
PDF (Portable Document Format) files on the User Documentation CD.

* The Quick Start Guide summarizes the steps for configuring the Xerox EX7750 and
printing. It also describes how to access the Adobe Acrobat PDF files on User
Documentation CD.

» The User Software Installation Guide describes how to install software from the
User Software CD and to enable users to print to the Xerox EX7750.

* The Configuration Guide explains basic configuration and administration of the
Xerox EX7750 for the supported platforms and network environments. It also
includes guidelines for setting up network servers to provide printing services to
users.

* The Printing Guide describes the printing features of the Xerox EX7750 for users
who send jobs from their computers.

* The Color Guide provides information on managing the color output of the
Xerox EX7750. It explains how to take advantage of the ColorWise® color
management system, as well as features in ColorWise Pro Tools.

* The Fiery Color Reference addresses concepts and issues associated with managing
color output of the Xerox EX7750. In addition, it offers information on printing
color documents from popular Microsoft Windows and Apple Mac OS

applications.

* The Job Management Guide explains the functions of the job management utilities,
and how you can use them to monitor and control jobs on the Xerox EX7750. This
manual is intended for a user with the necessary access privileges who monitors and
manages job flow, and troubleshoots problems that may arise.

* Customer Release Notes provide last-minute product information and workarounds
for some of the problems you may encounter.



Copyright © 2004 Electronics for Imaging, Inc. All rights reserved.

This product documentation is protected by copyright, and all rights are reserved. No part of it may be reproduced or transmitted in any form or by any means
for any purpose without express prior written consent from Electronics for Imaging, Inc. (“EFI”), except as expressly permitted herein. Information in this
document is subject to change without notice and does not represent a commitment on the part of EFL.

This product documentation is provided in conjunction with the EFI software (“Software”) and any other EFI product described in this documentation. The
Software is furnished under license and may only be used or copied in accordance with the terms of the Software License Agreement set forth below.

Patents

This product may be covered by one or more of the following U.S. Patents:

4,716,978, 4,828,056, 4,917,488, 4,941,038, 5,109,241, 5,170,182, 5,212,546, 5,260,878, 5,276,490, 5,278,599, 5,335,040, 5,343,311, 5,398,107,
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5,959,867, 5,970,174, 5,982,937, 5,995,724, 6,002,795, 6,025,922, 6,035,103, 6,041,200, 6,065,041, 6,112,665, 6,116,707, 6,122,407, 6,134,018,
6,141,120, 6,166,821, 6,173,286, 6,185,335, 6,201,614, 6,215,562, 6,219,155, 6,219,659, 6,222,641, 6,224,048, 6,225,974, 6,226,419, 6,238,105,
6,239,895, 6,256,108, 6,269,190, 6,271,937, 6,278,901, 6,279,009, 6,289,122, 6,292,270, 6,299,063, 6,310,697, 6,321,133, 6,327,047, 6,327,050,
6,327,052, 6,330,071, 6,330,363, 6,331,899, 6,340,975, 6,341,017, 6,341,018, 6,341,307, 6,347,256, 6,348,978, 6,356,359, 6,366,918, 6,369,895,
6,381,036, 6,400,443, 6,429,949, 6,449,393, 6,476,927, 6,490,696, 6,501,565, 6,519,053, 6,539,323, 6,543,871, 6,546,364, 6,549,294, 6,549,300,
6,550,991, 6,552,815, 6,559,958, 6,572,293, 6,590,676, 6,606,165, 6,633,396, 6,636,326, 6,643,317, 6,647,149, 6,657,741, 6,662,199, 6,678,068,
6,707,563, 6,741,262, 6,748,471, 6,753,845, 6,757,436, 6,757,440, RE33,973, RE36,947, D341,131, D406,117, D416,550, D417,864, D419,185,
D426,206, D439,851, D444,793.

Trademarks

Auto-Count, ColorCal, ColorWise, Command WorkStation, DocBuilder Pro, EDOX, EFI, Fiery, the Fiery logo, Fiery Driven, the Fiery Driven logo, Fiery Spark,
MicroPress, OneFlow, Printcafe, PrinterSite, PrintMe, Prograph, Proteus, RIP-While-Print, Splash, and Spot-On are registered trademarks of Electronics for
Imaging, Inc. in the U.S. Patent and Trademark Office and/or certain other foreign jurisdictions. Bestcolor is a registered trademark of Best GmbH in the U.S.
Patent and Trademark Office.

ADS, AutoCal, Balance, Build, Digital StoreFront, DocStream, Fiery Link, Fiery Prints, FreeForm, Hagen, Intelligent Device Management, Logic, PrintFlow,
PrintSmith, PrintSmith Site, PSI, PSI Flexo, RIPChips, Scan, SendMe, VisualCal, WebTools, the EFI logo, the Fiery Prints logo, and Essential to Print are
trademarks of Electronics for Imaging, Inc. Best, the Best logo, Colorproof, PhotoXposure, Remoteproof, and Screenproof are trademarks of Best GmbH.

All other terms and product names may be trademarks or registered trademarks of their respective owners, and are hereby acknowledged.
Legal Notifications

APPLE COMPUTER, INC. (“APPLE”) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE. APPLE DOES
NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE APPLE
SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE
RESULTS AND PERFORMANCE OF THE APPLE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT
PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL,
INCIDENTAL, OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS
OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE APPLE SOFTWARE, EVEN IF
APPLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.
Apple’s liability to you for actual damages from any cause whatsoever, and regardless of the form of the action (whether in contract, tort [including negligence],
product liability, or otherwise), will be limited to $50.

PANTONE® Colors displayed in the Software or in the documentation may not match PANTONE-identified standards. Consult current PANTONE Color
Publications for accurate color. PANTONE® and other Pantone, Inc. trademarks are the property of Pantone, Inc. © Pantone, Inc., 2001. Pantone, Inc. is the
copyright owner of PANTONE color data and/or software.

Part Number: 45043000
07 October 2004



This product includes software developed by the Apache Software Foundation (www.apache.org).

FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void
the user’s authority to operate this equipment.

Refer to the Class Compliance sticker affixed to the back of your Fiery (or, in the case of embedded systems, to the sticker affixed to the print engine) to identify
the appropriate classification (A or B, below) for this product.

Class A Compliance

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and
can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause interference, in which case the user will be required to correct the interference
at his own expense.

Industry Canada Class A Notice
This Class A digital apparatus complies with Canadian ICES-003.

Avis de Conformation Classe A de 'Industrie Canada

Cet appareil numérique de la Classe A est conforme a la norme NMB-003 du Canada.

Class B Declaration of Conformity

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed
to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded
cables is likely to result in interference to radio and TV reception. The user is cautioned that changes and modifications made to the equipment without the

approval of the manufacturer could void the user’s authority to operate this equipment.

Industry Canada Class B Notice
This Class B digital apparatus complies with Canadian ICES-003.

Avis de Conformation Classe B de I'Industrie Canada

Cet appareil numérique de la Classe B est conforme a la norme NMB-003 du Canada.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on a system level (to simulate normal
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user
who is responsible for compliance of his particular installation.

Dieses Gerit wurde sowohl einzeln als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funkentstérbestimmungen
gepriift. Es ist jedoch méglich, dass die Funkentstérbestimmungen unter ungiinstigen Umstinden bei anderen Geritekombinationen nicht eingehalten werden.

Fiir die Einhaltung der Funkentstérbestimmungen einer gesamten Anlage, in der dieses Gerit betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.



Die Einhaltung zutreffender Bestimmungen hiingt davon ab, dass geschirmte Ausfithrungen beniitzt werden. Fiir die Beschaffung richtiger Ausfiihrungen ist der
Betreiber verantwortlich.

CE Marking (Declaration of Conformity)
This product complies with the following EU directives: 89/336/EEC, 73/23/EEC, and 93/68/EEC directives. This declaration is valid for the area of the

European Union.

SOFTWARE LICENSE AGREEMENT

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT (“LICENSE AGREEMENT”) CAREFULLY. THIS LICENSE AGREEMENT IS A LEGAL
AGREEMENT BETWEEN YOU AND ELECTRONICS FOR IMAGING, INC. (“EFI”) REGARDING THE EFI SOFTWARE (“SOFTWARE”). BY
INSTALLING, COPYING OR OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS LICENSE AGREEMENT. IF YOU DO
NOT AGREE, DO NOT INSTALL, COPY, OR OTHERWISE USE THE SOFTWARE AND YOU MAY RETURN THE UNUSED SOFTWARE, WITH
PROOF OF PAYMENT, FOR A FULL REFUND TO THE PLACE OF PURCHASE WITHIN THIRTY (30) DAYS OF THE PURCHASE DATE.

License

EFI grants you a limited, non-exclusive license to use the Software solely in accordance with the terms and conditions of this License Agreement, solely as specified
in the EFI product documentation, and solely with the product(s) specified in the EFI product documentation (“Product(s)”).

The term “Software” as used in this License Agreement shall mean the EFI software and all documentation, downloads, on-line materials, bug fixes, patches,
releases, release notes, updates, upgrades, technical support materials, and information regarding the EFI software. The terms and conditions of this License
Agreement shall apply to and govern your use of any such item to the extent that EFI does not provide a separate or additional written license agreement for such
item.

The Software is licensed, not sold. You may use the Software solely for the purposes described in the EFI product documentation. You may not rent, lease,
sublicense, lend, or otherwise distribute the Software or use the Software in any time sharing, service bureau, or similar arrangement.

You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except one (1) backup or archive copy for the purposes
permitted in this License Agreement; provided, however, that under no circumstances may you make or have made, or permit to be made, any copies of any portion
of the Software that is included on any portion of the controller board or hardware of a product. You agree not to localize, translate, disassemble, decompile,
decrypt, reverse engineer, discover the source code of, modify, create derivative works of, or in any way change any part of the Software.

Intellectual Property Rights

You acknowledge and agree that all rights, title, and interest, including all intellectual property rights, in and relating to the Software, all EFI Products, and all
copies, modifications, and derivative works thereof, are solely owned by and shall remain with EFI and its suppliers. Except for the express limited license granted
in this License Agreement, no right or license of any kind is granted. You receive no rights or license under any patents, copyrights, trade secrets, trademarks
(whether registered or unregistered), or other intellectual property. You agree not to adopt, register, or attempt to register any EFI trademark or trade name or any
confusingly similar mark, URL, internet domain name, or symbol as your own name or the name of your affiliates or products, and agree not to take any other
action which impairs or reduces the trademark rights of EFI or its suppliers.

Confidentiality

The Software is confidential, proprietary information of EFI and you may not distribute or disclose the Software. You may, however, permanently transfer all of
your rights under this License Agreement to another person or legal entity provided that: (1) such a transfer is authorized under all applicable export laws and
regulations, including the laws and regulations of the United States, including the United States Export Administration Regulations; (2) you transfer to the person
or entity all of the Software (including all copies, updates, upgrades, media, printed documentation, and this License Agreement); (3) you retain no copies of the
Software, including no backup, archival, or other copies, however stored; and (4) the recipient agrees to all of the terms and conditions of this License Agreement.

Termination

Unauthorized use, copying, or disclosure of the Software, or any breach of this License Agreement will result in automatic termination of this license and will make
available to EFT other legal remedies. In the event of termination, you must destroy all copies of the Software and all component parts thereof. All provisions of
this License Agreement relating to confidentiality of the Software, disclaimers of warranties, limitation of liability, remedies, damages, governing law, jurisdiction,
venue, and EFI’s intellectual property rights shall survive any termination of this license.

Limited Warranty and Disclaimer

EFI warrants that the Software, if used as specified in the EFI product documentation, will perform substantially in accordance with the EFI product
documentation for a period of ninety (90) days from the date of receipt. EFI makes no warranty or representation that the Software will meet your specific
requirements, that the operation of the Software will be uninterrupted, secure, fault-tolerant, or error free, or that all defects in the Software will be corrected. EFI

makes no warranty, implied or otherwise, regarding the performance or reliability of any other Products or services or any third party products (software or
hardware) or services. THE INSTALLATION OF ANY THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS



WARRANTY. USE, MODIFICATION, AND/OR REPAIR OF THE SOFTWARE OR AN EFI PRODUCT OTHER THAN AS AUTHORIZED BY EFI
WILL VOID THIS WARRANTY. FURTHER, THIS LIMITED WARRANTY IS VOID IF A PROBLEM WITH THE SOFTWARE ARISES FROM
ACCIDENT, ABUSE, MISAPPLICATION, ABNORMAL USE, VIRUS, WORM, OR SIMILAR CIRCUMSTANCE.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, EXCEPT FOR THE EXPRESS LIMITED WARRANTY SET FORTH ABOVE
(“LIMITED WARRANTY”), EFI MAKES AND YOU RECEIVE NO REPRESENTATIONS OR WARRANTIES RELATING TO THE SOFTWARE, ANY
PRODUCT AND/OR ANY SERVICES, WHETHER EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION OF THIS AGREEMENT
OR ANY OTHER COMMUNICATION. EFI SPECIFICALLY DISCLAIMS ALL IMPLIED WARRANTIES, REPRESENTATIONS, AND
CONDITIONS, INCLUDING THOSE OF SECURITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT OF THIRD PARTY RIGHTS. THERE IS NO WARRANTY OR REPRESENTATION THAT THE OPERATION OF THE
SOFTWARE AND/OR ANY PRODUCT WILL BE UNINTERRUPTED, FAULT-TOLERANT, SECURE, OR ERROR-FREE. TO THE MAXIMUM
EXTENT PERMITTED BY APPLICABLE LAW, YOUR SOLE AND EXCLUSIVE REMEDY, AND THE ENTIRE LIABILITY OF EFI AND ITS
SUPPLIERS, RELATING TO ANY AND ALL SOFTWARE, PRODUCTS, SERVICES, AND/OR APPLICABLE WARRANTIES SHALL BE, AT EFI’'S
OPTION, (1) TO REPAIR OR REPLACE THE SOFTWARE THAT DOES NOT MEET THE LIMITED WARRANTY; OR (2) PROVIDE A REFUND
OF THE PRICE PAID (IF ANY) FOR THE SOFTWARE THAT DOES NOT MEET THE LIMITED WARRANTY. EXCEPT AS PROVIDED IN THIS
SECTION, EFI AND ITS SUPPLIERS SHALL PROVIDE NO REFUNDS, RETURNS, EXCHANGES, OR REPLACEMENTS.

Limitation of Liability

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, YOU AGREE THAT THE ENTIRE LIABILITY OF EFI AND ITS SUPPLIERS
FOR ALL CLAIMS RELATED TO ANY SOFTWARE, PRODUCT, SERVICES, AND/OR THIS LICENSE AGREEMENT, REGARDLESS OF THE
FORM OF ACTION (WHETHER IN CONTRACT, TORT, UNDER STATUTE, OR OTHERWISE), SHALL BE LIMITED TO THE AMOUNT PAID
BY YOU, IF ANY, FOR THE EFI SOFTWARE. YOU AGREE THAT SUCH AMOUNT IS SUFFICIENT TO SATISFY THE ESSENTIAL PURPOSE OF
THIS LICENSE AGREEMENT AND THAT SUCH A LIABILITY IS A FAIR AND REASONABLE ESTIMATE OF ANY LOSS AND DAMAGE LIKELY
TO BE SUFFERED IN THE EVENT OF ANY WRONGFUL ACT OR OMISSION BY EFI AND/OR ITS SUPPLIERS. TO THE MAXIMUM EXTENT
PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL EFI AND ITS SUPPLIERS BE LIABLE FOR COST OF PROCUREMENT OF
SUBSTITUTE SOFTWARE, PRODUCTS OR SERVICES, LOST PROFITS OR DATA, THIRD PARTY CLAIMS, OR ANY SPECIAL INDIRECT,
RELIANCE, CONSEQUENTIAL, EXEMPLARY, PUNITIVE, OR INCIDENTAL DAMAGES, HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, RELATED TO ANY SOFTWARE, PRODUCT, SERVICES AND/OR THIS LICENSE AGREEMENT. THIS LIMITATION SHALL APPLY
EVEN IF EFI AND ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. YOU AGREE THAT THE PRICE OF THE
EFI SOFTWARE REFLECTS THIS ALLOCATION OF RISK. YOU ACKNOWLEDGE AND AGREE THAT THE FOREGOING LIMITATIONS OF
LIABILITY AND DISCLAIMERS FORM AN ESSENTIAL ELEMENT OF THIS LICENSE AGREEMENT, WITHOUT WHICH EFI WOULD NOT
HAVE LICENSED THE EFI SOFTWARE TO YOU.

BECAUSE SOME JURISDICTIONS DO NOT ALLOW SOME OR ALL OF THE EXCLUSIONS AND/OR LIMITATIONS OF LIABILITY HEREIN,
SOME OR ALL OF THE ABOVE EXCLUSIONS AND LIMITATIONS MAY NOT APPLY TO YOU.

You are hereby notified that Adobe Systems Incorporated, a Delaware corporation located at 345 Park Avenue, San Jose, CA 95110-2704 (“Adobe”) is a third-
party beneficiary to this License Agreement to the extent that this License Agreement contains provisions which relate to your use of any software, font programs,
typefaces, and/or trademarks licensed or supplied by Adobe. Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition
to EFI. ADOBE WILL HAVE NO LIABILITY WHATSOEVER TO YOU FOR ANY ADOBE SOFTWARE OR TECHNOLOGY LICENSED
HEREUNDER.

Export Restrictions

The Software and EFI Products are subject to the export laws and regulations of the United States, including the United States Export Administration Regulations.
The license granted to you herein is conditioned upon your compliance with all applicable export laws and regulations, including the export laws and regulations
of the United States. You represent and agree that you will not use, disclose, distribute, transfer, export, or re-export any portion of the Software or any EFI Product
in any form in violation of any applicable export laws and regulations, including the export laws and regulations of the United States.

U.S. Government Restricted Rights

Use, duplication, or disclosure of the Software by the United States Government is subject to restrictions as set forth in FAR 12.212 or DFARS 227.7202-3 -
227.7202-4 and, to the extent required under U.S. federal law, the minimum restricted rights as set out in FAR 52.227-14, Restricted Rights Notice (June 1987)
Alternate ITI(g)(3) (June 1987) or FAR 52.227-19 (June 1987). To the extent any technical data is provided pursuant to the Agreement, such data is protected per
FAR 12.211 and DFARS 227.7102-2 and to the extent explicitly required by the U.S. Government, is subject to limited rights as set out in DFARS 252.227.7015
(November 1995) and DFARS 252.227-7037 (September 1999). In the event that any of the above referenced agency regulations are modified or superseded, the
subsequent equivalent regulation shall apply. The name of the Contractor is Electronics for Imaging, Inc.



Governing Law and Jurisdiction

The rights and obligations of the parties related to this License Agreement will be governed in all respects by the laws of the State of California exclusively, as such
laws apply to contracts between California residents performed entirely within California. The United Nations Convention on Contracts for the International
Sale of Goods and any other similar convention does not apply to this License Agreement. For all disputes related to the Software, Products, Services, and/or this
License Agreement, you consent to the exclusive personal jurisdiction and venue of the state courts in San Mateo County, California and the federal court for the
Northern District of California.

General

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Products, Services,
and any other subject matter covered by this License Agreement. If any provision of the License Agreement is held invalid, such provision shall be deemed modified
to the extent necessary to be enforceable and the other provisions in this License Agreement shall continue in full force and effect.

If you have any questions, see the EFI web site at www.efi.com.

Electronics for Imaging, Inc.
303 Velocity Way

Foster City, CA 94404

USA


http://www.efi.com
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xi | About this manual

Introduction This manual describes how to install user software for the Xerox EX7750, and how
to set up printing from Microsoft Windows and Apple Mac OS computers. For
information about setting up network servers and clients to use the
Xerox EX7750, see the Configuration Guide. For general information about using
the Phaser 7750, your computer, application software, or network, see the manuals
that accompany those products.

Note: Illustrations of Windows software may not necessarily reflect the version of
Windows that you use.

The EX7750 includes support for WebTools™ and software for Command
WorkStation®/ Command WorkStation LE, which allow an operator to manage all jobs
sent to the EX7750. Although it may not be the case at all sites, the documentation for
this product assumes the presence of an operator who controls and manages jobs sent
by users from remote workstations.

About this manual

This manual covers the following topics:
* Installing printer files on Windows and Mac OS computers
* Setting up printing connections on Windows and Mac OS computers

* Installing Fiery® utilities and other user software on Windows and Mac OS
computers



xii

Introduction

Specifications

Supports the Fiery Advanced Controller Interface (FACI), which includes a monitor,
a keyboard, and mouse

Supports AppleTalk, TCP/ID, and IPX/SPX protocols simultaneously
Supports Port 9100

Supports unshielded twisted pair (Gigabit Ethernet 1000BaseTX, Fast Ethernet
100BaseTX, or Ethernet 10BaseT)

Supports Adobe PostScript 3

Supports PCL 6 printing (for Windows computers)

Built-in ColorWise color management and NetWise networking management
Supports Fiery utilities and WebTools (see following sections)

Fiery utilities, including ColorWise Pro Tools, Fiery Downloader, Fiery Spooler
(Mac only), and E-mail Port Monitor and Fiery Printer Delete Ustility (both
Windows only)

WebTools, including Status, WebLink, WebDownloader, and Installer
Command WorkStation (Windows only) software

Command WorkStation LE (Mac OS X Native only) software
Supports EFI Impose

Supports E-mail printing

Note: Fiery utilities and EX7750 user software can be installed on the EX7750 from
the User Software CD, using the FACI. Other third-party applications are not

supported and may cause system problems.



xiii

User software

User software

EX7750 user software is provided on the User Software CD.

Adobe PostScript

Printer Driver

PostScript Printer
Description (PPD) file

PostScript fonts
(Mac OS only)

PCL Printer Driver

Fiery Downloader

ColorWise Pro Tools

Command WorkStation
(Windows only)

Enables you to print to the EX7750 from Mac OS
computers; also supports EX7750 and PostScript 3
features. Windows XP users should use the Microsoft
PostScript Printer Driver provided with those
operating systems.

For use with the PostScript printer driver that allows
the EX7750 to appear in the Print and Page Setup
dialog boxes of popular applications. The EX7750
PPDs provide information about the EX7750 and your
Phaser 7750 to the application and printer driver you
are using.

PostScript screen and printer fonts that correspond
to the PostScript printer fonts installed on the
EX7750. For a complete list of PostScript fonts
installed on the EX7750, see Appendix B of

the Printing Guide.

Enables you to print to the EX7750 from Windows
computers; supports EX7750 PCL print features.

Enables you to print PostScript files, PCL files,
Encapsulated PostScript (EPS) files, TIFF version 6.0
files, and Portable Document Format (PDF) versions
1.2, 1.3, and 1.4 files directly to the EX7750 without
opening the application in which they were created.
You can also use it to manage the printer fonts installed
on the EX7750.

ICC-open color management and calibration tools;
enables you to edit and download ICC profiles.

Enables the operator to control the EX7750 functions
from Windows computers. To use Command
WorkStation, see the Job Management Guide.
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Command WorkStation LE
(Mac OS X Native
Mode only)

EFI Fiery Mail Port
(Windows only)

Adobe Acrobat and PitStop
software (Windows only)
Acrobat and PitStop are
provided on the Fiery
DocBuilder Pro kit CD.

Color management files

Color reference files

Calibration files

MR] (Mac OS only)

Enables the operator to control EX7750 functions
from Mac OS X Native computers. To use Command
WorkStation LE, see the Job Management Guide.

Enables you to send jobs to the EX7750 in the form of
e-mail attachments by adding the Fiery Mail Port
software as a printer port.

Adobe Acrobat and the PitStop Acrobat plug-in are for
use with the Command WorkStation DocBuilder Pro
feature. PitStop offers you enhanced PDF

editing functions.

ICC (Windows) and ColorSync (Mac OS) color
management files that enable you to maintain
consistent color from your original artwork to the
colors displayed on your monitor and then to the
printed output.

Reference pages that you can print to view the range of
colors available on your EX7750. For the most
predictable color results, refer to these pages when
defining colors in applications. For more information
on color management, see the Color Guide.

Includes measurement files and targets that you can use

with ColorWise Pro Tools.

Mac OS Runtime for Java (MR]) software is required
by all Java-based Fiery utilities. If MR] is not detected
when you install these utilities, the MR] installer is
automatically launched from the User Software CD.
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WebTools

WebTools allow you to manage your EX7750 remotely from the Internet or from your
company’s intranet. You access WebTools from the WebTools home page.

WebTools Summary For more information

Status Shows you the jobs currently processing | See the Printing Guide.
and printing.

WebLink Provides a link to another web page, See the Printing Guide and
provided you have a valid Internet the Configuration Guide.
connection.

Installer Allows you to download EX7750 printer | See Chapter 3.

file and other software installers directly
from the server.

WebDownloader | Allows you to download PostScript, See the Printing Guide.
PCL, EPS, and PDF files to the
EX7750.

System requirements

System requirements are described in detail in the printed Quick Start Guide provided
in your media pack.
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Chapter 1: This chapter describes the procedures for installing software and setting up printing
Installin g from a computer using a supported version of Windows. For the Windows versions

supported, see the Quick Start Guide.
User Software PP

on a Windows
Computer

The general steps for installing the software are as follows:

* Install the PostScript printer driver or PCL printer driver and corresponding printer
driver files and set up the printer driver to communicate with the EX7750.

* Install Fiery utilities and user software.

* Configure the connection for Fiery utilities and user software.

Install Adobe Acrobat and PitStop software from the Fiery DocBuilder Pro CD on
the designated Windows computer(s).

* Copy additional files from the User Software CD as required.

If you have other Fiery printer drivers already installed on your computer, use the Fiery
Printer Delete Utility to remove them. For details, see “Installing Fiery utilities” on
page 1-19 and “To use Fiery Printer Delete Utility” on page 1-23.

Setting up PostScript or PCL printing with
Windows 2000/XP

To set up the EX7750 as a PostScript or PCL printer, you must install the PostScript or
PCL printer driver for Windows 2000/XP and the corresponding printer description
files. You must also configure the print connection between the computer and the
EX7750. If you are printing over a network, you must configure a network connection.

NoTe: The procedures for configuring the options for the PostScript and PCL printer
drivers are similar. The following illustrations show the PostScript driver. Differences

are noted.
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Installing the PostScript or PCL printer driver for
Windows 2000/XP

The following procedure describes installing the printer driver from the User
Software CD or from the Installer WebTool. Subsequent procedures describe setting
up the print connection.

Note: To install the printer driver on a Windows 2000 computer, you must have
Service Pack 4 installed on the computer. To install the printer driver on a
Windows XP computer, you must have Service Pack 1 installed on the computer.
Otherwise, a warning message alerts you to install the proper service pack after

installation is complete.

Note: The following procedures use Windows XP illustrations; Windows 2000
differences are noted.

TO INSTALL THE POSTSCRIPT OR PCL PRINTER DRIVER
FOR WINDOWS 2000/XP

1.

On Windows 2000, click Start, choose Settings, and then choose Printers to display the
Printers window.

On Windows XP, click Start, choose Settings, and choose Printer and Faxes.

On Windows 2000, double-click the Add Printer icon and click Next.
On Windows XP, click Add a printer under Printer Tasks.

Click Next in the Welcome window.

Specify printing using a Local printer and click Next.

This procedure describes the installation of a local printer. You can modify the
connection later, according to your network type.
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5. Select LPT1: and click Next.

Add Printer Wizard

Select a Printer Port
Computers communicate with printers through ports,

Select the port you want your printer to uze. |F the port iz not listed, you can create a
new part.

() Use the following port: | [IEIER [Recommended Printer Port]

Mote: Most computers use the LPT1: port to communicate with a local printer.
The connector for this port should look something like this:

\\_ “...Il % — X

& g

() Create a new port:

[ < Back ” Mext > ][ Cancel ]

6. In the dialog box displaying lists of manufacturers and printers, click Have Disk.
The Install From Disk dialog box prompts you for the disk.

7. If you are installing from the User Software CD, insert it into the CD-ROM drive. Type
in the name of the CD-Rom drive or browse to it (for example, D:\), and then to the

English \Prntdrvr\Ps_drvr\Win_2K_XP folder or the
English \Prntdrvr\Pcl6_drvr\Win_2K_XP folder.

If you are installing from the files you downloaded using the Installer WebTool,
browse to English\prntdrvr\Prntdrvr\Ps_drvr\Win_2K_XP or
English\prntdrvr\Prntdrvr\Pcl6_drvr\Win_2K_XP and click Open.

8. Make sure “Oemsetup.inf” or “Oemsetup” is selected and click Open.

The path is displayed in the Install From Disk dialog box.
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9. Verify that the path is correct and click OK.

10. Select the Xerox EX7750 as your printer and click Next.

Add Printer Wizard

Install Printer Software
The manufacturer and madel determing which printer zafbware to use

) _'_\ Select the manufacturer and model of pour printer. | your printer came with an installation
disk, click Hawe Disk. |f pour printer is not listed, consulk your printer documentation for
compatible printer software.

Printers
Herox Phaser EX7750 PS

& This driver iz not digitally signed! [ “Windows Update ] [ Hawe Disk... ]
Tell me why driver signing is important

[ < Back ” Mext > ][ Cancel ]

11. Type a name for the printer in the Printer name field, choose whether you want to use
this printer as the default printer, and click Next.

This name will be used in the Printers window and the queues window.

Add Printer Wizard

Name Your Printer
“Y'ou must assign a name to thiz printer.

Type a name for thiz printer. Because some programs do not support printer and server
name combinations of mare than 31 characters, it is best to keep the name az short az
poszzible.

Frinter name:
|Aerd

Do you want ta uze thiz printer az the default printer?

O)es
& Mo

< Back ” Mext > ][ Cancel
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12.

13.

Follow the instructions in the remaining dialog boxes.
Choose whether to share this printer or not.

When asked whether to print a Test Page, select No.

Click Finish.
The necessary files are installed to your computer.
Note: If chis is the first printer driver you are installing on the computer, you may be

prompted to install files from the Windows 2000 CD. Insert the CD-ROM, browse to
the win2000\english\i386 folder, and then click OK.

When installation is complete, the Printers window appears with an icon for the newly
installed printer. You must now configure the options installed on your printer.

Configuring installed options

After you have completed the printer driver installation, you must configure the
EX7750 to reflect the options installed on the printer. This allows the EX7750 to take
advantage of the printer options. You can configure the options manually; or for
TCP/IP network connections, you can use the Two-Way Communication feature to
configure the options automatically.

Configuring installed options manually

The following procedure describes how to manually configure the EX7750 for the
options installed on the printer.

TO CONFIGURE INSTALLABLE OPTIONS ON THE EX7750 FROM THE POSTSCRIPT
PRINTER DRIVER FOR WINDOWS 2000/XP

1.

On Windows 2000, click Start, choose Settings, and then choose Printers.

On Windows XP, click Start, choose Settings, and choose Printers and Faxes.
Right-click the EX7750 icon and choose Properties from the file menu.
Click the Configuration tab.

Select an option from the Available Options list.
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5.

6.

Click Add to move the option to the Installed Options list.

& hero Properties @E‘
General Sharing Ports Advanced Color Management Securty
Device Settings Printer Gtatus Configuration ihout

'a Available Options:

Finisher —
Phager 775067
R |
N

&
ﬁ Installed Options: [~ Two-Way Communication
Fhaser 77500XF
|
-
Defaults

Finisher—Not Installed, Installed
Phaser 7750GX—Not Installed, Installed
Phaser 7750DX F—Not Installed, Installed

Click OK to activate the current settings.

TO CONFIGURE INSTALLABLE OPTIONS ON THE EX7750
FROM THE PCL PRINTER DRIVER

1.

On Windows 2000, click Start, choose Settings, and then choose Printers.

On Windows XP, click Start, choose Settings, and choose Printers and Faxes.
Right-click the EX7750 icon, and choose Printing Preferences.
Click the Configuration tab and specify the options installed on the EX7750.

Select an installed option from the Available Options list, and click Add to move
the option to the Installed Options list.

Click Apply, then click OK.
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Configuring installed options and updating print options
settings automatically

If you have a TCP/IP-enabled network, you can automatically update your printer
driver to reflect the options currently installed on the EX7750. When the printer
driver is first installed, the installable options have default settings that were set up in
EX7750 Setup or ColorWise Pro Tools. When you update the printer driver with the
Two-Way Communication feature, you allow the EX7750 to complete the actual
setting.

The Two-Way Communication feature also updates Expert Color Settings options to
reflect the current color settings on the EX7750. To access the Expert Color Settings

options, click the Expert Settings tab in the ColorWise print option bar of the Fiery

printing tab of your printer driver. For more information, see the Color Guide.

SETTING UP TWo-WAY COMMUNICATION FOR POSTSCRIPT
OR PCL PRINTER DRIVERS FOR WINDOWS 2000/XP

7.

Note: The procedures for setting up Two-Way Communication for the PostScript
printer drivers for Windows 2000/XP are similar. The following procedure displays
Windows XP illustrations. Differences are noted in the text.

On Windows 2000, click Start, choose Settings, and then choose Printers.

On Windows XP, click Start, choose Settings, and choose Printers and Faxes.
In the Printers window, select the icon for the EX7750 PostScript printer driver.

For the PostScript printer driver, choose Properties from the File menu.

For the PCL printer driver, choose Printing Preferences from the File menu.
Click the Configuration tab.

Select Two-Way Communication.

Enter the EX7750 IP address or DNS name.

If you want your printer driver to display the current settings when opened, select the
Update Fiery Driver When Opened option, and then click Update.

Note: To confirm that Two-Way Communication is enabled, click the About tab.
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8. To receive an e-mail notification after your job has been printed, select Enable E-mail
Notification, and type in the e-mail address to which an e-mail notification is sent.

You will also receive e-mail notification of any errors that occur during printing.

Note: Enable E-mail Notification is displayed only if Email Service is enabled at Setup.

Note: Make sure to clear the check box for Enable advanced printing features in the
Advanced tab.

9. Click OK.

Completing the Windows 2000/XP printer connection
To print from Windows 2000/XP, you must:

* Set up network servers, if any.
¢ Set up the EX7750 to accept print jobs from your computer.

* Configure a port on each Windows 2000/XP computer for the network type.

To do this See
Configure the TCP/IP (LPR port) “Completing the Windows 2000/XP TCP/IP
connection and Port 9100 or LPR connection” on page 1-8
Configure the IPX (Novell) connection “Completing the Windows 2000/XP IPX

(Novell) connection” on page 1-13

Configure the IPP connection “Setting up IPP printing with
Windows 2000/XP” on page 1-17

Completing the Windows 2000/XP TCP/IP and Port 9100 or LPR connection

After you have installed the PostScript and printer driver files, complete the setup
for the TCP/IP and LPR connection as follows:

* Prepare the EX7750 to accept print jobs using TCP/IP and LPR protocols.
For details, see the Configuration Guide.

* Enable LPD or Port 9100 from the EX7750 FACI. For details, see the Configuration
Guide.

* Configure the computer for the TCP/IP connection.
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Before you continue, contact the system administrator for the IP address assigned to
the EX7750, as well as the subnet mask and the gateway address, if they are used.

NoTE: You can also set up the LPR connection by installing Print Services for UNIX,
which is supplied as an add-on Windows component with your Windows 2000/XP

CD. For more information, see your Windows documentation.

To SeT up TCP/IP AND PORT 9100 OR LPR CONNECTION
FOR WINDOWS 2000/XP

Note: The following procedures use Windows XP illustrations.

1. Open the Properties dialog box for the EX7750 and click the Ports tab.

2. Click Add Port.

&  Aero PS Properties El@

| Printer Status — Accessolies About
Genersl | Shaing | Pots | Advancsd | ColorMansgement | Secuity | Devics Setings |
@ Aero
Frint ta the following port(s). Documents will print to the first free
checked port.
| Port Description Printer
Frintter Part

O LPTZ  Printer Port
O LPT2  Pinter Port
O com1: Seial Poit
[ COM2: Serial Port
O com3: Serial Poit
O coma: Serial Port

[ Add Port... ] [ Delete Part ] [ Configure Part... ]

[1Enable printer poaling
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3. Select Standard TCP/IP Port for Available port types and click New Port.

Printer Ports

Available port bypes:
EFI Fiery Mail

Local Part
FDF Port
Standard TCP/IF Port

[ Mew Part Type... ] Mew Port... ][ Cancel

4. Click Next.
The Add Standard TCP/IP Printer Port Wizard dialog box appears.

5. Type the IP address of the EX7750.

Add Standard TCP/IP Printer Port Wizard

Add Port
For which device do you want to add a port?

[

Enter the Printer Mame or IP address, and a port name for the desired device.

Printer Mame or |P Address: || |

Part Mame: | |

< Back “ Mext » ][ Cancel

6. Click Next.

7. Make sure that Generic Network Card is selected as Standard for Device Type and
click Next.

8. Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box and click
Close in the Printer Ports dialog box.
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9. Click Configure Port in the Ports tab of the Properties dialog box.

Configure Standard TCP/IP Port Monitor @El

Port Settings

Part Marne: 1P_10.11.143.101

Frinter Name or [P Address: 10111431001

Praotocal

O Raw @ LFR

Fiaw Settings

LFR Settings
Queue Mame: z

] LPR Byte Counting Enabled

SNMP Status Enabled

Community Name: public

SMMP Device Index: |1

The Configure Standard TCP/IP Port Monitor dialog box appears.

10. If you have LPD printing enabled at the EX7750 FACI, select LPR for Protocol and LPR
Byte Counting Enabled under LPR Settings.

NoTE: You can also proceed without selecting LPR Byte Counting Enabled under
LPR settings.

11. If you have Port 9100 printing enabled at the EX7750 FACI, select Raw.
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12.

13.

14.

The port number 9100 automatically appears under Raw Settings. This allows you to
print to the printer connection that your administrator selected for Port 9100 printing
in EX7750 Setup. You can also specify a port number as instructed in the next step.

Configure Standard TCP/IP Port Monitor

Port Settings

Port Marne: 1P_10.11.143.101

Frinter Name or [P Address: 10111431001

Protocol

) Raw @®LPR

Faw Sethings

LPR Settings
Queue Mame: H

[JLPR Eyte Counting Enabled

SNMF Status Enabled

Community M ame: public

SNMP Device Index:  [{

Enter the name of the print connection.
For LPR, enter direct, print, or hold in the LPR Settings area.
Port 9100 is displayed in the Raw Settings area for direct, print, or hold queues.

Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.

Click Close to close the Ports tab.
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Completing the Windows 2000/XP IPX (Novell) connection

Complete the setup for the IPX (Novell) connection as follows:

* Configure the Novell network and file server for handling EX7750 print jobs. The
file server should be configured with a print server and print connection for the
EX7750. For details, see your NetWare documentation.

* Prepare the EX7750 for IPX printing.
¢ Set up the IPX connection on the computer.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client
services should already be installed on the Windows 2000/XP computer.

To SeT upP IPX (NOVELL) PRINTING FOR WINDOWS 2000/XP

NoTe: The following procedures use Windows 2000 illustrations.

1. On Windows 2000, double-click My Network Places.
On Windows XP, click My Network Places.

2. Double-click NetWare or Compatible Network.

A list of NetWare servers appears.

I~ HetwWare or Compatible Hetwork M= 3
J File Edit “iew Go Favorites Help |
S R = -
Back Fanyard Up Map Drive
J Address Metware or Compatible Metwork j
coving a8 P o
@ desktopd11-2 @ qa_main @ qar
@ desktop00 @ Aero @ gad
di_ga_j @ qaZ qaj2
@ efi @ ga3 @ serverl_tree
@ het-dey @ gad @ ts_efi
@an‘I_l,les_tree qah Color
K — i
|50 object(s) v
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7.

Double-click the NetWare Tree or File Server on which the network administrator
defined a print connection for the EX7750.

You may have to log in to the file server to see the print connections.
Double-click the print connection defined for the EX7750.

If the NetWare server does not have a suitable driver for the EX7750, you may be
asked if you want to set up the printer on your computer. Click Yes.

Click OK to install the EX7750 PostScript printer driver.

Follow steps 6-10 of the procedure “Installing the PostScript or PCL printer driver for
Windows 2000/XP” on page 1-2.

When installation is complete, a new printer window appears, with the name of the
print queue on the NetWare server.

Choose Properties from the File menu and click the Ports tab.

Verify that the connection to the NetWare queue is listed and selected as a port for
the EX7750.

& Aero Properties E|E\

Device Settings PFrinter Status Configuration About
General Sharing Forts Advanced Color Management Security
1\@
= g Aero
Frint ta the following port(s). Documents will print ta the first free
checked port.
Port Description Printer had
Frinter Part

O LPTZ  Printer Port
O LPT2  Piinter Port
O comt: Seisl Port
[ cOM2: Serial Port
O com3: Serial Poit
O com4: Serial Poit v

[ Add Part... ] [ Delete Part ] [ Configure Part...

[1Enable printer poaling
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9.

10.

Click the General tab and click Print Test Page.

In the printer Job Notes field, type user and job identification information and
click OK.

The Test Page remains listed in the queue window until it is printed.

The EX7750 polls the NetWare server for print jobs in the print connection defined
for the EX7750. When you print, your PostScript files are spooled to that connection
and transmitted over the queue “port” to the EX7750.

Setting up SMB printing on Windows 2000/XP

SMB printing (also known as Windows printing) allows you to install the printer
driver and associated files, and print from your computer to a particular print
connection (Hold, Print, or Direct) on the EX7750. These instructions assume you
have installed the TCP/IP protocol and Client for Microsoft Networks.

Each connection (Hold, Print, or Direct) requires a new printer driver and printer
description file. To set up printing to a second or third print connection, repeat the
procedure, “Setting up SMB printing on Windows 2000/XP”. If you install more than
one printer, give each a descriptive name during printer driver installation, such as
Aero-Print or Aero-Hold, so you can easily identify printers.

BEFORE YOU BEGIN

To check the setting for Enable SMB Print Services, print a Configuration page.

Note: The default setting for Enable SMB Print Services on the EX7750 is Yes.

To change the setting, right-click the FieryBar on the FACI and choose Setup Fiery to
configure the EX7750. Then select Network Setup > Services > Windows Print Sharing
(SMB) > Enable SMB Print Services.

At the Control Panel, configure the EX7750 for SMB printing in Run Setup > Network
Setup > Service Setup >Windows Setup.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map,
and on the Configuration page. For more information, see the Configuration Guide.
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To SET uP SMB PRINTING ON WINDOWS 2000/XP

1.

2.

Open My Network Places.

Browse for the printer you want to print to.

The printer name you are browsing for is the name entered in Network Setup >
Service Setup > Windows Setup > Server Name. For this information, see the
Configuration page.

The amount of network traffic determines the amount of time required for the
Browse function.

NoTE: You can also locate the printer using the Search feature on your Windows
computer. Right-click My Network Places and click Search for Computers. Type the
name of the printer and click Search Now.

If you are not able to locate your EX7750, contact your network administrator.
Double-click the name of the EX7750 to display enabled print connections.

Double-click the name of the connection you want to print to.

The Printers dialog box appears, asking whether you want to set up the printer.

Printers

Before you can use the printer “\Aero bdirect,' it must be sat up on your computer. Do you want Wwindows to set up the
printer and continue this operation?

Select Yes to complete the installation for the selected connection.

Windows 2000/XP downloads the printer driver and printer description files from the
EX7750 to your computer and installation is complete.

For more information, see “Installing the PostScript or PCL printer driver for
Windows 2000/XP” on page 1-2.
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Setting up IPP printing with Windows 2000/XP

With Internet Printing Protocol (IPP), print jobs are sent to the EX7750 over
the Internet.

IPP printing is supported directly for Windows 2000/XP computers.

Note: The IPP setup procedures are performed after installing the appropriate printer
drivers (see “Installing the PostScript or PCL printer driver for Windows 2000/XP” on

page 1-2).

BEFORE YOU BEGIN

1.

2.

3.

Prepare the EX7750 for TCP/IP printing.

Prepare the EX7750 for IPP printing.

For more information, see the Configuration Guide.

Specify the printing destination on your computer.

To SET uP IPP PRINTING FOR WINDOWS 2000/XP

1.

On Windows 2000, click Start, choose Settings, and then choose Printers.

On Windows XP, click Start, choose Settings, and choose Printers and Faxes.

On Windows 2000, double-click the Add Printer icon and click Next.
On Windows XP, click Add a printer under Printer Tasks.

Click Next in the Welcome window.

Select Network printer and click Next.
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5.

7.

10.

Select “Connect to a printer on the Internet or on your intranet.” Type an IP address
or computer name in the URL field.

The URL for the printer is the IP address or DNS name followed by “ipp/print”.
Insert slashes between the different elements.

nddprmcerwizard |

Locate Your Printer
Hows do you want to locate your printer?

If you don't know the name of the printer, you can browse for one on the network.

‘what do you want to do’?

" Type the printer name, or click Next to browse for a printer

M ame: I

&' Connect to a printer on the Intemet or on your intranst

URL: Ihttp:.-".-"‘l 0.11.151.23/ipp/print

< Back I Mest > I Cancel

Click Next.

The Connect to Printer dialog box appears.

Click OK.
The Add Printer Wizard dialog box appears.

If you are installing the PostScript printer for Windows 2000/XP for the first time,
follow the procedure described on page 1-2.

If you have already installed the printer driver on your computer, choose the
appropriate names from the Manufacturers and Printers lists and click OK.

Indicate whether you want to make the printer the default printer and click Next.

Click Finish.
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Installing Fiery utilities

From the User Software CD, you can install the following Fiery utilities and

user software:

* ColorWise Pro Tools

* Fiery Job Monitor

* Fiery Printer Delete Utility
¢ Fiery Mail Port

* Command WorkStation

Includes DocBuilder Pro. Adobe Acrobat and PitStop, a plug-in for Adobe Acrobat,
are provided on the Fiery DocBuilder Pro kit CD.

* Fiery Downloader

NoTe: Do not attempt to install DocBuilder Pro from the User Software CD (by
starting the setup.exe from the DocBuilder Pro folder); it is automatically installed
when you install Command WorkStation. Installing DocBuilder Pro from the User
Software CD can cause unpredictable results. In order to use DocBuilder Pro, you
must install Acrobat and the Impose dongle.

Note: Job Monitor is automatically installed when you install the printer driver on
your computer. To use Job Monitor, you first need to enable it in the printer driver.

The Fiery utilities must be separately installed on each user’s computer. The
installation of each utility is similar.

To use EX7750 software (Command WorkStation, and ColorWise Pro Tools) as well
as WebTools on a Windows computer, you must install the Sun Java file, Java Runtime
Environment (JRE), provided in the CommonUtl folder on the User Software CD. If
the Sun Java file is not installed, you are prompted to install it before you proceed to
EX7750 software. For more information about installing Java Runtime Environment
(JRE), see “To install Sun Java on your computer” below. For more information about

WebTools, see the Job Management Guide and the Printing Guide.
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To install the software, you must have Service Pack 4 on a Windows 2000 computer,
and Service Pack 1 installed on your Windows XP computer. If not, a warning message
alerts you to install the Service Pack.

TO INSTALL SUN JAVA ON YOUR COMPUTER

1. When the dialog box prompting you to install Java Runtime Environment (JRE)
appears, click OK to proceed with installation.

2. Click Yes in the License Agreement dialog box.
3. Select Typical for Setup Type and click Next.

4. When installation of Java Runtime Environment (JRE) files is complete, click Finish
and follow the instructions for installing EX7750 software on page 1-19.

After installation of the Sun Java files, a Java Web Start shortcut is created on your
computer desktop. This is not intended for use with EX7750 software, so you may
delete the shortcut if you wish.

To INSTALL FIERY UTILITIES
1. Open the appropriate folder for the software you want to install.
2. Double-click the Setup.exe icon.

3. Follow the instructions in the Setup dialog boxes to complete installation.

BEFORE YOU BEGIN

¢  Print the Configuration page from the Control Panel and note the IP address of
the EX7750.

e  Print the Configuration page from the FACI and note the IP address of the EX7750.
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Adobe Acrobat

In Command WorkStation, the DocBuilder Pro feature works with Adobe Acrobat
and the PitStop software plug-in for Acrobat. DocBuilder Pro is installed with
Command WorkStation. To use Docbuilder Pro, you must install Acrobat and the
PitStop plug-in, and Command WorkStation. Acrobat and PitStop are provided on the
Fiery DocBuilder Pro kit.

Note: If Acrobat is installed after Command WorkStation, you may be required to
restart Command WorkStation in order to use Impose.

NoTe: To use Impose, you must have the dedicated dongle installed to the parallel port
on your computer. If the dongle is not installed, refer to the documentation packaged
with the dongle.

For more information about Acrobat for Windows, see the Readme.pdf file on the
DocBuilder Pro CD.

TO INSTALL ACROBAT

1.

2.

Insert the DocBuilder Pro CD in the CD-ROM drive.
Open the Acrobat folder, and double-click AutoPlay.exe.

Follow the on-screen instructions.

All languages are installed.
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PitStop

PitStop is a plug-in for Acrobat for use with DocBuilder Pro. You must first install
Acrobat as described in the previous section. PitStop software is included on the
DocBuilder Pro CD.

To INSTALL P1TSTOP

1.

2.

On the DocBuilder Pro CD, double-click to open the PitStop folder.

Choose the setup icon for the language you want to install.

English, French, German, and Spanish are the languages that are supplied and are
indicated by a two-letter identifier. For example, in the file name, pp_5.setup_de.exe,
“de” represents German. The identifiers for the other languages are: us (English),

fr (French), and es (Spanish).

Double click the PitStop setup icon you want.

The Welcome to Enfocus PitStop Setup dialog box appears,
Click Next and then click Yes to the license agreement.
The Information dialog box appears.

Note: Make sure to complete the Enfocus Certified PDF Personal Information form.
Otherwise, the form will appear every time you launch Acrobat.

Click Next.
The Choose Destination Location dialog box appears.

PitStop will automatically select the correct location for installation.

Click Next.

Setup is complete.

Click Finish.

For more information, see the PitStop documentation in Acrobat under Help > Plug-in
Help\Enfocus PitStop Professional.
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Using Fiery utilities for the first time

Before you can use the newly installed software, you must configure the connection to
the EX7750. Configuration of the Fiery utilities is similar.

Fiery Printer Delete Utility is installed and used locally, so connection to the EX7750
is not required before using the software.

To USE FIERY PRINTER DELETE UTILITY

1.

2.

Click Start, choose Programs, and then choose Fiery.

Click FieryPrinterDeleteUtility.

The Fiery Driver Uninstall Tool dialog box appears. If any EX7750 printer drivers are
found on your computer, they are displayed.

Select a Printer:
---Mo EFI Printers Found----

Driver Files:
---Mo EFI Printer Files Found----

Exit About [elete

"“"imaging-

To delete any of the displayed printers, select the printer name and click Delete.
Click OK to delete the selected printer driver.

Click OK to restart, or, to delete another printer driver, click Cancel to return to the
Fiery Driver Uninstall Tool dialog box. Restart your computer when you finish deleting
printer drivers.
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Configuring the connection for Fiery utilities

The first time you start one of the Fiery utilities, you must configure the connection to
the EX7750. Similar configuration is used for all Fiery utilities, so any change in one
configuration affects all the other connections. Configuration for most Fiery utilities is
described in the following procedure.

For configuration of specific Fiery utilities, see the following:
* “Configuring the connection for EFI Fiery Mail Port” on page 1-27

* “Configuring the connection for Command WorkStation” on page 1-30

BEFORE YOU BEGIN

Print the Configuration page from the EX7750 Control Panel and note the IP address of
the EX7750.

Print the Configuration page from the FACI and note the IP address of the EX7750.

This page contains information you need when configuring the connection, such as
the IP address. For TCP/IP installations, you can use the DNS name of the EX7750
instead of the IP address. Make sure the EX7750 is already registered in a Domain
Name Server (DNS) on your network. For more information, see your Windows

system documentation.
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TO CONFIGURE THE CONNECTION FOR FIERY UTILITIES

1.

2.

Start the utility for which you want to configure a connection.

If the No Fiery Configured dialog box appears, click OK.
If the Choose Printer Device dialog box appears, click Add.

Enter the appropriate information for the EX7750.

Nickname—Enter a name for the EX7750. This name does not have to match the
actual Server Name of the EX7750.

Note: The nickname cannot contain the following characters:
[]_""<space> <tab>

Protocol—Choose the type of network protocol you are using from the menu.

Note: Fiery utilities are not supported over IPX/SPX. Command WorkStation is
supported on Windows computers over TCP/IP.

Server Name—Enter the IP address (or DNS name) of the EX7750.
New Device—Enter the name of the device the EX7750 is connected to: EX7750.
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Note: Type EX7750 exactly as shown because this term is case-sensitive.

Add New Server

Nickriame I

Communication Typ

Frotocol [Tcrap =l

Server Name I

New Device

Lodd

Fermove |

Devices

[k | Cancel |

4. When you have entered all the information, click Add.

5. With the device name (EX7750) selected in the Devices list, click OK.

The EX7750 appears in the list of Available Servers. The first line of the entry displays
the nickname you gave the server, followed by the protocol you chose. The second line

displays the device name.

Choose Printer Device

Available Servers
=5 EAem [TCPIP] Add.

= levicehames

WGdify

Device name of the
EX7750 (EX7750) REROYE |

Select Cancel

6. With the device name selected in the list of Available Servers, click Select to begin
using the utility.
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Modifying the configuration

Edit the configuration whenever there is any change to your EX7750 server or
network, such as a server name or IP address. If you change EX7750 Setup

information, do so before reconfiguring the connection.

To MODIFY THE CONFIGURATION

1.

To edit information for a EX7750 in the list of available servers, select the EX7750 by
its nickname and click Modify.

Make the necessary changes in the Modify Server Settings dialog box and click OK.

To add a new EX7750 to the list of available servers, click Add. Configure the Add New
Server dialog box as outlined in steps 3 through 5 in the previous procedure.

To remove an EX7750, select the EX7750 by its nickname and click Remove.

NoTe: The nickname cannot be modified.

Configuring the connection for EFI Fiery Mail Port

The E-Mail Service provides a method to print and control the EX7750 remotely. Jobs
are sent to the EX7750 in the form of e-mail attachments. You can set up e-mail
printing on Windows computers by adding the Fiery Mail Port software as a printer
port.

To set up the EX7750 for e-mail printing, see the Configuration Guide. After Setup has
been performed, install the software from the User Software CD onto your Windows
computer, and then add a port.

On Windows 2000, click Start, choose Settings, and then choose Printers.

On Windows XP, click Start and choose Printers and Faxes.

In the window displaying a list of ports, click Add Port.
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The Printer Ports dialog box appears, with the Fiery Mail port listed as one of the
available ports.

Printer Ports EHE

Awailable Printer Ports:

Y
Lexmark DLC Metwork Port
Lexmark TCP/P Metwork Port

Local Port
FDF Part

Mew Monitor... |
Mew Port... I Cancel |

7. Select Fiery Mail and click New Port.
The Add Port dialog box appears.

Add Port [ 7]x]
r— Fiery's E-mail Addre:

r— Outgoing Mail Server [SMTP)

|
Advanced ... | Cancel | QK I

8. Enter the basic information required to set up the e-mail port.
Fiery’s E-mail Address—Enter the e-mail address of the EX7750.

Outgoing Mail Server—Enter the name or IP address of the SMTP server for the port
monitor to use.

9. Click Advanced.
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The E-Mail Port Configuration dialog box appears.

E-Mail Port Configuration EHE

— Fiery Server

E-mail Address: IQA‘I (@efi.com

Queue: | Print =l

r— Outgoing Mail Server [SMTP)
Server Name: [ ailServer@compary. com Poit: [25

From Address: | LRKPIOWN U RRNOW. UREN D

— Optio:
V' Break apart messages larger thanl 1024 kB (B4kB - 1024kE]

™ Status messages from Fiery

Cancel | ()8 I

10. Enter the following information.
For Fiery Server:
E-mail Address—The e-mail address of the EX7750.
Queue—The print connection on the EX7750 that you want.
For Outgoing Mail Server (SMTP):
Server Name—The SMTP server to use.
From Address—The “from” address to insert in the e-mail.
For Options:

Break apart messages larger than—The maximum size of a single e-mail message
is displayed. If a job exceeds this size, it is split into multiple messages, each not
exceeding this size, and is sent to the EX7750. The EX7750 then automatically
combines all split messages into the original single print job for printing.

Status messages from Fiery—When enabled, the Status option requests the EX7750 to
send status reports of the job printed to the print queue via e-mail.

11. Click OK.
The Add Printer Wizard dialog box appears.

12. Click Next and follow the instructions for installing the printer driver for your
Windows computer.
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Configuring the connection for Command WorkStation

The first time you start Command WorkStation, you are prompted to configure the
connection to the EX7750.

TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION

1. Print a Configuration page.

The information on this page helps you locate the EX7750, if it is not on the same

local subnet as your computer.

2. Start Command WorkStation.

The Available Servers dialog box appears. All servers found in the local subnet

are displayed.

Auto Search | Manuall
Befresh | Advanced... |

Mame | Device Mame | IP Address |

1 |

fdd Close |
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4.

If no EX7750 servers were found, click the Manual tab to search by DNS name
or IP address. Click Add to add the server to the Available Servers list.

Available Servers E

Auto Search  Manual |

—Mew Server

7 Server DNS Mame: I
& Server [P address: I . . .

Mote: The Fiery DMS Mame or [P address must be entered
exactly as it is configured, or this utility will not be able ta find
it o the network.

Advanced Search

IP Address | e |

IP hdcess  Subres |

iz (> IP Hanaas
10 .11 130

To P address
10,11 160, |

Add | Bemove |

I3 Subnets l

Subnet mazk

[

Add | Remove |

Search for compatible Fierys thraugh a range of IP addresses by
entering the "From IP" and "'To [P addresses in the fields
above. Tou can specify multiple 1P ranges.

Enter any known [P addiess and subnet mask combination.
Advanced Search lists Fiems in the same subnet.

Search | LCloze |

Search | Close |

Click Search.

All available servers appear in the Available Servers list.
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5. Select the EX7750 server you want to use and click Add.
The selected EX7750 appears in the Login Server dialog box.

#. Login Server

6. Click the server name.

The Login dialog box appears.

Login : SERVYER-184077

i

T T
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7. Select Administrator, Operator, or Guest and click Log In.
Enter the password when prompted.

Your computer is connected to the EX7750.

Modifying the configuration

Edit the configuration whenever there is any change to your EX7750 server or
network, such as a server name or IP address. If you change EX7750 Setup

information, do so before reconfiguring the connection.

To MODIFY THE CONFIGURATION
1. Start Command WorkStation.

The Login Server window appears.

2. Select the EX7750 server for which you want to modify the configuration,
and click Remove.

3. To add the modified EX7750 server, follows steps 3 through 5 of the
previous procedure.

To modify the connection to the EX7750, you must remove the server from the Login
Server list and follow the procedure for configuring the connection.
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Installing color files from the User Software CD

You can copy additional color files from the User Software CD to your computer.
Many of the files are PostScript files that you can download and print using
Fiery Downloader.

ICC folder ICC monitor settings file and a device profile specially designed
for use with the EX7750 and the printer. For instructions on
installing, see “Installing the ICC profiles on a Windows
computer” on page 1-35.

Windows Cmyk.ps, an 11-page, letter-size PostScript file to use for
Color Files reference when defining CMYK colors in applications.
folder

Pantone.ps, a 19-page, letter-size PostScript file that indicates
the closest equivalent of PANTONE coated colors that the
EX7750 and your printer model can produce. The method used
to print the Pantone.ps file differs depending on the Spot Color
Matching setting. For more information, see the Printing Guide

and the Color Guide.

Rgb_01.doc, a file you can print from Microsoft Word 97 or

later to view available RGB colors.

Rgb_02.ppt, a file you can print from PowerPoint 6.0 or later to
view available RGB colors.

Calibrat folder ~ Four PostScript files of color patches for obtaining

(inside the measurements: Custom21.ps, Custom34.ps, Stand21.ps, and
Windows Stand34.ps. The numbers in the file names refer to the number
Color Files of patches on the page. The Custom files allow you to download
folder) measurement patches that incorporate the current calibration set

of the printer. The Standard files allow you to download standard
measurement patches that bypass the current calibration set of
the printer. For information about using these files, see

the Color Guide.

Note: These files are provided for expert users and should not be
used for day-to-day calibration.



1-35 | Installing color files from the User Software CD

Installing the ICC profiles on a Windows computer

The ICC profiles included in the Icc folder on the User Software CD are for use

with ColorWise Pro Tools. You can also use the ICC profiles with applications that
support ICC standards, such as Photoshop. For most ICC-aware applications, the files
must be installed in a folder named Color in the System Folder. For use with
ColorWise Pro Tools, you can copy the files to a folder of your choice.

You can upload additional ICC profiles with the Profile Manager in ColorWise Pro
Tools. For more information about uploading and using ICC profiles with ColorWise
Pro Tools, see the Color Guide.

To INSTALL THE ICC PROFILES ON A WINDOWS COMPUTER

1.

2.

On the User Software CD, open the Icc folder.

If you are using Windows 2000, copy the profiles to the Winnt\System32\Color folder
on your computer.

Note: If a folder named “Color” does not exist in the System32 folder, create one and
install the profiles into it.

If you are using Windows XP, right-click the profile you want and click Install Profile.

Note: The profiles are installed automatically to the
Windows\System32\spool\drivers\color folder on your computer.
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Loading the monitor settings file

The Efirgb.icc monitor settings file can be used in Adobe Photoshop, or other
applications that support ICC profiles, to define a source color space for printing to

the EX7750.

These instructions assume you have installed the ICC profiles included on the
User Software CD. For more information, see the preceding section.

Note: The internal name of an ICC profile may vary slightly from its file name.

To LOAD THE RGB WORKING SPACE PROFILE FOR PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose RGB Setup from the Color
Settings submenu.

3. In the RGB Setup dialog box, click Load.

 BEB: | Monitor RGB =l o]
GEamma: Iﬁ Cancel |
white Paint: | 6S00°K (DES) =l Load... |
Primaries: | HOTY (CCIR 709 j Save... |
— Monitor: sRGE I Ereview
¥ Display Using Manitor Compensation

4. For Windows Windows 2000, browse to the Winnt\System32\Color folder, select
Efirgb.icc, and then click Load.

For Windows XP, browse to the Windows\System32\spool\driver\color folder, select
Efirgb.icc, and then click Load.

The Efirgb v1f file is displayed in the RGB menu of the RGB Setup dialog box.

5. Click OK.

For more information about ICC profiles, see your Photoshop documentation.
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Loading the ICC printer device profile
This ICC profile defines the target color space for printing to the printer.

These instructions assume you have installed the ICC profiles included on the
User Software CD. For more information, see “Installing the ICC profiles on a
Windows computer” on page 1-35.

Note: The internal name of an ICC profile may vary slightly from its file name.

To LoAD THE ICC PRINTER DEVICE PROFILE IN PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose CMYK Setup from the Color
Settings submenu.

3. In the CMYK Setup dialog box, choose ICC as the CMYK color model.

4. Select the profile that corresponds to the EX7750 from the Profile menu.

CMYK Setup E
CMYK Model: € Built-in & 1CC ¢ Tables
ICC Options ] |
IR <P rofilename=
L. |
Engine: | Built-in -
I J Saye.. |
Intent: | Perceptual {Images) j
™ Preview
¥ Black Point Compensation

5. Click OK.

For more information about ICC profiles, see your Photoshop documentation.
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Loading monitor settings files and ICC printer device profiles in
Photoshop 6.x/7.x

After you have installed the Efirgb.icc monitor settings file and the ICC profile for the
EX7750, follow the procedure below to load them in Photoshop 6.x/7 x.

TO LOAD THE MONITOR SETTINGS FILE AND ICC PRINTER DEVICE
PROFILE IN PHOTOSHOP 6.X/7.X

1.

2.

Start Photoshop.

Choose Color Settings from the Edit menu and select Advanced Mode in the Color
Settings dialog box.

Choose EFI RGB from the RGB menu.
Choose the profile that corresponds to the EX7750 from the CMYK menu.

Click OK.

For more information, see your application’s documentation.
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Installing the printer description files for Windows

The User Software CD contains printer description files for popular Windows
applications. Adobe Pagemaker 6.x and 7.x do not support automatic installation of
printer description files from the Printers or Printers and Faxes Control Panel. To make
the EX7750 available in the Print and Page Setup dialog boxes of this application, copy
printer description files to the appropriate location.

To COPY THE PRINTER DESCRIPTION FILES

1. On the User Software CD, open the English\Prntdrvr\Ps_drvr folder. Select the folder
that corresponds to the language system you are using.

For Windows 2000/XDP, select \Prntdrvr\Ps_drvr\Win_2K_XP.

2. Copy the printer description file for your EX7750 to the appropriate location.

If you use Copy this file To this location
PageMaker 6.5/7.0 EF6X6626.PPD For PageMaker 6.5,
\PM65\RSRC\USENGLSH\PPD4
For PageMaker 7.0,
\PM7\RSRC\USENGLSH\PPD4
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Ch apter 2: The general steps for installing the EX7750 user software and setting up printing on a
Ins talling Mac OS computer are as follows:

User Software * Install the PostScript printer driver and printer description file.

on a Mac 0S ¢ Set up the EX7750 in the Chooser (Mac OS 9 or Mac OS X Classic mode) or in the
Computer Print Center (Mac OS X Native mode).

* Install the Fiery utilities.

Note: Command WorkStation LE is only available for Mac OS X Native. All other
utilities are available for Mac OS 9 and Mac OS X Classic.

* Configure the connection for Fiery utilities.

* Install the printer and screen fonts.

Install the ColorSync profiles.

Install additional color reference and application-specific files.

In addition to using the User Software CD, you can download printer drivers from the
EX7750 with the Installer WebTool (if the site administrator has enabled Internet
access to the EX7750). For instructions, see “Using the WebTools Installer” on

page 3-2.

Once you download the printer files, the installation process is identical to installing
from the User Software CD.



2-2 | Installing User Software on a Mac 0S Computer

Setting up the EX7750 as a PostScript printer

To set up the EX7750 as a PostScript printer, you must install the PostScript printer
driver and the printer description file that corresponds to your Phaser 7750. The
PostScript printer driver and printer description files are provided on the User
Software CD. Printer drivers provide a way to communicate information on print jobs
between your applications, the EX7750, and any other PostScript printer connected to
your computer.

When you install printer files from the User Software CD or printer files downloaded
using the Installer WebTool, use the following procedures.

Setting up Mac 0S 9 printer drivers and printer description files

The following instructions describe how to set up printer drivers and printer
description files.

To INSTALL THE ADOBEPS PRINTER DRIVER AND PRINTER
DESCRIPTION FILE FOR MAC 0S 9

1.

Quit all open applications.
After you have completed installation, restart your computer.

On the User Software CD, open the 0S9 folder and then the English: Printer Driver
folder.

If you are installing from files you downloaded using the Installer WebTool, open the
Printer Driver folder on your hard disk.

Double-click the AdobePS Installer icon.

Follow the on-screen instructions.

The AdobePS Installer installs the Adobe PostScript printer driver, and the printer
description file that corresponds to the EX7750.

NoTte: If you operate the EX7750 in a copy shop, quick print shop, or service bureau,
provide your customers with copies of the printer driver, printer description file, or
ICC profiles you use for printing images, as well as any relevant documentation. This
ensures that jobs they create and print to files are properly formatted for printing to

the EX7750.
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Setting up the EX7750 in the Chooser

After you install the Adobe PostScript printer driver and printer description file (see
“Setting up the EX7750 as a PostScript printer” on page 2-2), you must set up the
EX7750 in the Chooser in order to take full advantage of its features. This section
describes how to set up the EX7750 with the AdobePS printer driver.

Note: We recommend that you set the Multiple Users function to Off.

To SET UP THE EX7750 IN THE CHOOSER
1. Select Chooser from the Apple menu.
Make sure AppleTalk is set to Active.

2. Select the correct AppleTalk Zone, if necessary.

3. Click the AdobePS icon.

The EX7750 appears in the Select a PostScript Printer list in the form of
<server name>_<print connections.

Note: Only the print connections (Direct, Hold, and Print) that have been enabled
in Setup appear in the Chooser.

0= (hooser———————
- Select a PostScript Printer:
= Aera_Direct s
Aero_Print =
#ppleShare iadobels Aero_Hold
& Archipelago
AppleTalk Zones:
US CA 303 Tech Pubs =
US CA 303 Tech Pubs Lab1
US CA 303 Tech Support Labl ~|
US CA 303 Tech Support Lab2
US CA 303 Tech Support Lab3
US CA 303 Technical Support [|
appleTalk  ® lmt':.e
() Inactive 7.6.2
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Select a EX7750 connection from the “Select a PostScript Printer” list
and click Create.

Select the correct printer description file for your printer.

NoTE: You must set up each print connection separately. Repeat this step for all
enabled connections.

With the same printer selected, click Setup, and then click Configure.

In the Installable Options dialog box, select the appropriate settings from the menus
and click OK.

@ Current Printer Description File (PPD) Selected:
“Xerox Phaser EX7750 P5*

Installable Options

Phaser Configuration: | Phaser 7750DXF ¢|
Finisher Option: | Not Installed ¢|

[ Cancel ]H 0K ]l

Click OK to close options for the printer.

Close the Chooser.
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Setting up Mac 0S X v10.2 printer drivers and printer
description files

The following instructions are for Mac OS X v10.2 and v10.3 Native mode. The term
“Mac OS X” is used in this chapter to refer to Mac OS X v. 10.2.5 through 10.3.1.

The User Software CD contains the following software for Mac OS X inside the
OSX folder:

* OSX Installer—this application installs the printer driver files (PPDs) necessary to
print from Mac OS X.

Note: Fiery utilities as well as WebTools are not supported on Mac OS X.

* Language folders—these folders contain copies of the printer description files that
will be installed by the PPD Installer. You do not need to open these folders or install
them manually on your computer; the appropriate files will be installed by the
PPD Installer.

TO INSTALL THE PRINTER DESCRIPTION FILES
FOR MAC 0S X v10.2

Note: Fiery utilities as well as WebTools are not supported on Mac OS X v10.2.

1. Quit all open applications.

2. Make sure that Print Center is not running on your computer.

Print Center updates the list of available printers when it restarts; if a printer
description file is added while Print Center is running, you cannot select the associated
printer model until you restart Print Center.

Note: For Mac OS X 10.3, choose Printer Setup Utility.
3. Insert the User Software CD into the CD-ROM drive.
4. Open the Printer Driver folder inside the 0SX folder on the User Software CD.
5. Click the OSX Installer icon to start installing printer description files.

6. Follow the on-screen instructions.

The PPD Installer installs the printer description files that correspond to the EX7750.

After you have completed installation, restart your computer.
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Setting up the EX7750 in the Print Center

Note: Mac OS X 10.2 screens are shown. Differences are noted wherever necessary.

To SET UP THE EX7750 IN THE PRINT CENTER ON AN
ENGLISH SYSTEM

1. Click Application in the Go menu, choose Utilities, and then choose Print Center.

Note: For Mac OS X 10.3, choose Printer Setup Utility.

&

8 Printer List =]

& @0 ¥

Make Default | Add Delete Configure

ﬁmm |

10.11.143.22

AERO_Print
Atlas
Bailey

2. Click Add in the Printer List dialog box.
3. Choose AppleTalk or IP printing in the menu that appears.

4. For AppleTalk, choose the AppleTalk Zone, and then choose the name of the EX7750.
If the zone is not listed as the Default Zone, or one of the Recent Zones, select
AppleTalk Network, select the zone, and click Choose. Proceed to step 6.

(AppleTalk ]
(UsCA303 TechPubs i)
Type
AERO_Direct PostScript printer
AERO_Hold PostScript printer
AERO_Print PostScript printer
AIZU_7040_Direct PostScript printer r
AIZU_7040_Print PostScript printer [y
Character Set:Western v|
Printer Model: {Autn Select i
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For IP Printing, enter the IP address or DNS name of the printer for Printer's Address,
clear Use default queue on server, and then enter the print connection for
Queue Name.

Note: Enter the printer Queue Name for the print connection. You cannot use the

same Queue Name for more than one printer.

j 008 Printer List O k

(1P Printing B

Printer's Address:

Internet address or DNS name

g Use default queue on server

Queue Name:

Printer Model: {Generic D

For Printer Model, select the appropriate manufacturer name, and then select the file
for the EX7750 PPD.

5. Click Add.

6. Proceed to “To configure installable options” on page 2-10.

To SET UP THE EX7750 IN THE PRINT CENTER ON A
NON-ENGLISH SYSTEM

1. Double-click Print Center in ‘Utilities’ under Startup disk/Application.

eo0e Printer List (=]
8 &9 w
S : =
Make Default | Add Delete Configure
[ 5 as | |

10.11.143.22

AERO_Print
Atlas
Bailey
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2. Click Add in the Printer List dialog box.
3. Choose AppleTalk or IP printing in the pop-up menu.

4. For AppleTalk, choose the AppleTalk Zone, and then choose the name of the EX7750.
If the zone is not listed as the Default Zone, or one of the Recent Zones, select
AppleTalk Network, select the zone, and click Choose.

(AppleTalk 3]
[USCA303 TechPubs i)
Type
AERO._Direct PostScript printer
AERO_Hold PostScript printer
AERO_Print PostScript printer
AIZU_7040_Direct PostScript printer r
AIZU_7040_Print PostScript printer v
Character Sat'Wastarn |
Printer Model: {Aurn Select i
i)

For IP Printing, enter the IP address or DNS name of the printer for Printer’s Address,
clear Use default queue on server, and then enter the print connection for
Queue Name.

Note: Enter the printer Queue Name for the print connection. You cannot use the
same Queue Name for more than one printer.

j 008 Printer List O k

(1P Printing B

Printer's Address:

Internet address or DNS name

s Use default queue on server

Queue Name:

Printer Model: {Generic D
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5.

6.

For Printer Model, select Other.

Choaose a File
From: { [ it.Iproj i
E p I" o b (=] AERO_Hold
e.lproj [@ HP Busines...kjet 2250.92

3 enlproj " B [@ HP Busines...kjet 2280.9z
3 es.iproj " B [@ HP Busines...kjet 2600.9z
@ fitproj . [@ HP Color Laserjet 5M.gz
[ frlproj " I [@ HP Color La.. Jet 4500.9z
[ itlproj "1 [@ HP Color La.. Jet 4550.9z
ﬁ Ja.lproj " B hp color Laserjet 4600.gz
3 kolproj " 1Y [@ HP Color La.. Jet 8500.9z |3
@ nLiproj " |3 [@ HP Color La._Jet 8550.92 |v
€ L - XCH

GCo to: | |

Add to Favorites ( Cancel ) ’f Choose }

A

In the Choose a File dialog box, select the appropriate language file from the left
column, and the EX7750 name from the right column.

The following table explains which file name corresponds to your language.

Language File name
Dutch nl.lpro
English en.lproj
French fr.lproj
German de.lproj
Italian it.lproj
Japanese ja.lproj
Portuguese pt.lproj
Spanish es.lproj
Swedish sv.lproj

NoTEe: These files are located on your hard drive in System Folder: Library: Printers:
PPDs: Contents: Resources.
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7.

8.

Click Choose.

Click Add in the Printer List window.

For more information about adding printers, see your Mac OS X documentation.

TO CONFIGURE INSTALLABLE OPTIONS

1.

Double-click Print Center in Utilities under Startup disk/Application.

The Print Center launches.

Note: For Mac OS X 10.3, choose Printer Setup Utility. Select your printer in the
Printer List.

&

e Printer List (=]

L @0

Make Default | Add Delete Configure

[ s | |

10.11.143.22

AERO_Print
Atlas
Bailey

A

Choose Show Info from the Printer menu.
Choose Installable Options in the menu that appears.
In the Printer Info dialog box, choose the appropriate settings.

Click Apply Changes and close the dialog box.
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Installing EX7750 software and fonts

The Mac OS installers function essentially the same for each type of software. Before
you begin each installation, determine where you want to install each item on your
hard disk drive. Otherwise, the software is placed by default as follows:

¢ ColorSync profiles—ColorSync Profiles folder
If you are using ColorSync 2.5, install the profiles into the ColorSync Profiles folder

inside the System Folder. If you are using an earlier version of ColorSync, install the
profiles into the ColorSync Profiles folder inside the System Folder: Preferences

folder. The printer profile can be moved to a folder of your choice.

* Fiery Downloader, Fiery Spooler, ColorWise Profiler, and ColorWise Pro Tools—
“Fiery” folder

* Fonts—System Folder: Fonts folder

For instructions on installing Fonts, see “Fonts” on page 2-22.

To INSTALL MAC OS SOFTWARE

1. Insert the User Software CD into the CD-ROM drive and double-click the Installer icon
of the item you want to install, then follow the instructions in the installer dialog
boxes.

2. If prompted, click Quit to close the software installer.
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Installing MRJ on your computer

In order to use ColorWise Pro Tools, Fiery Downloader, or Fiery Remote Scan, you
must have Mac OS Runtime for Java (MR]) installed on your computer.

If you do not have MR] installed, the ColorWise Pro Tools, or Fiery Downloader
installer automatically initiates the MR] installation process.

Note: The respective installer prompts the MR] installation from the User Software
CD. MRJ 2.2.5 is provided on the User Software CD.

TO INSTALL MAC OS RUNTIME FOR JAVA

1. Open the MRJ folder on the User Software CD and double-click Installer.

2. Read the Apple Computer Inc. License Agreement and click Agree to install
the software.
3. Click Install.

Some files are installed.

4. Click Quit.

You are now ready to configure the ColorWise Pro Tools and Fiery Spooler
connections to the EX7750.

We recommend that you use the version of MR] provided on the User Software CD
with the EX7750 software.

If you have a newer version of MR]J (such as 2.2.5) already installed on your computer
and experience some difficulty using the EX7750 software, either remove or relocate
the MR] files currently installed (using the following procedure) and reinstall the
version of MR] provided on the User Software CD.
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TOo UNINSTALL MAC OS RUNTIME FOR JAVA

1. Locate the System Folder on your hard disk.

2. Inside the Extensions folder, locate MRJ Libraries and remove it or move it to
another folder.

Note: If you find the “MR]J Enabler” file under Extensions, remove it or move it to
another folder.

3. Locate the Apple Extras folder inside the Applications folder on your hard disk.

4. Inside the Apple Extras folder, locate Mac 0S Runtime Java, and remove it or move it
to another folder.

5. Restart your computer.
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Configuring a connection for ColorWise Pro Tools

The first time you use ColorWise Pro Tools, you are prompted to configure a
connection to the EX7750.

BEFORE YOU BEGIN

¢  Print the Configuration page from the Control Panel and note the IP address of
the EX7750.

¢  Print the Configuration page from the FACI and note the IP address of the EX7750.

TO CONFIGURE A CONNECTION FOR COLORWISE PrRO TOOLS
1. Start the utility by double-clicking its icon.

For Fiery Remote Scan, start the supported TWAIN-compliant software. For details,
see the Printing Guide.

The Choose Printer Device dialog box appears.

=——— Choose Printer Device

Available Servers

setlect | [ cancel |
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2.

If you have previously configured a connection to the EX7750, you are ready to use
ColorWise Pro Tools. If you have not configured a connection, click Add.

Add Server

Nickname | |

C ication Type

Protocol [Tcpap z]

Server Name | \

New Device

| | Add
Devices
j
S

Enter the appropriate information for the EX7750.

Nickname—Enter a name for the EX7750. It does not have to match the actual server
name of the EX7750.

Note: The nickname cannot contain the following characters:
[]_"" <space> <tab>

Protocol—TCP/IP is the only supported network protocol, so no selection is necessary.
Server Name—Enter the IP address (or DNS or hosts name) of the EX7750.

New Device—Enter the name of the device the EX7750 is connected to: EX7750.
This device name appears in the Printer Setup section of the Configuration page.

Note: Type EX7750 exactly as shown; this term is case-sensitive.
When you have added all the information, click Add.

With the device name selected in the Devices list, click OK.

The EX7750 appears in the list of Available Servers. The first line of the entry displays
the nickname you gave the server, followed by the protocol. The second line displays
the device name.
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With the device name selected in the list of Available Servers, click Select to begin
using ColorWise Pro Tools.

Choose Printer Device

Available Servers

Device name of the EX7750
(EX7750)

=--Rero [TCP/IP] Add...
Remove
Modify

[ setect | [ cancel |

Modifying the configuration

Edit the configuration whenever there is any change to your EX7750 or network, such
as an IP address or device change. Change the specific EX7750 Setup information
before configuring the connection.

To MODIFY THE CONFIGURATION

1.

2.

In the Chooser dialog box, click Option.

To edit information for a EX7750, select the EX7750 by its IP address or DNS name and
click Modify. Edit information in the Settings dialog box as necessary, and click OK.

To add a new EX7750, click Add. Configure the Settings dialog box as outlined in steps
3 through 5 in the preceding procedure.

To remove a EX7750, select the EX7750 by its IP address or DNS name, and click
Remove.

The list of Available Servers reflects the modifications you have made.
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Configuring a connection for Fiery Spooler

BEFORE YOU BEGIN

e  Print the Configuration page from the Control Panel and note the IP address of
the EX7750.

¢  Print the Configuration page from the FACI and note the IP address of the EX7750.

TO CONFIGURE THE CONNECTION FOR FIERY SPOOLER

1. Start the utility by double-clicking its icon.
The Chooser dialog box appears.

2. Click Option.
3. Click Add.

4. Enter the appropriate information for the EX7750.

O="—"—————settils=—"——U~=H

Name

New Device

Add

(—4 Remove

0K ] I Cancel ]
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Name—Enter the IP address (or DNS name) of the EX7750.

New Device—Enter the name of the device that the EX7750 is connected to: EX7750.
This device name appears in the Printer Setup section of the Configuration page.

NoTe: Type EX7750 exactly as shown; this term is case-sensitive.
When you have entered all the information, click Add.

With the device name selected, click OK.

The EX7750 appears in a list of configured servers.

[O0=—————Confilure=———"-H

Manually configured servers

5.
6.
EX7750 name and device
name (EX7750)
7.

Rero_<device name>

Cancel

Remove

[~ Modify...

il

Click OK in the Configure dialog box.
The EX7750 appears in a list of Available Servers.

O=————————(Chooser——————H

Available Servers

& RAero _<devicename>

EX7750 name and device
name (EX7750)

8. With the EX7750 selected in the list of Available Servers, click OK to begin using

Fiery Spooler.
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Configuring the connection for Fiery Downloader and Command
WorkStation LE for Mac 0S X

The first time you start Fiery Downloader or Command WorkStation LE, you are
prompted to configure the connection to the EX7750.

BEFORE YOU BEGIN

e  Print the Configuration page from the Control Panel and note the IP address of
the EX7750.

¢  Print the Configuration page from the FACI and note the IP address of the EX7750.

To SPECIFY A EX7750 CONNECTION FOR FIERY DOWNLOADER

1. Double-click the Fiery Downloader icon.

2. Select the AppleTalk zone in which the EX7750 is located from the AppleTalk
Zones list.

The available servers appear in the Servers list.

Please select:

AppleTalk Zones: Servers:
US CA 303 Tech Pubs = AERO _<devi b =]
US CA 303 Tech Pubs Lab1 AlZU EX7750 name and device name
US CA303Tech SupportLab1 ASAMA (EX7750)

US CA 303 Tech Support Lab2
US CA 303 Tech Support Lab3
US CA 303 Technical Support

[l

Connect

3. Select the EX7750 in the Servers list.
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4. Click Connect.

The Fiery Downloader dialog box appears.

| US CA 303 Tech Pubs: AERD Status =H

2, Downloader

r Print Status
Status Idle

User :

Document:

r RIP Status
Status Idle

User

Cocurnent:

P Progress
Downloading:

r Hard Disk

Hard Disk 2067 ME 1755 ME Free
EEE ]

For information about using Fiery Downloader, see the Printing Guide.

BEFORE YOU BEGIN

¢  Print the Configuration page from the Control Panel and note the IP address of
the EX7750.

e Print the Configuration page from the FACI and note the IP address of the EX7750.
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TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION LE

1. Start Command WorkStation LE.

The Available Servers dialog box is displayed. All servers found in the local subnet
are displayed.

NoTe: The device name for the EX7750 is EX7750.

800 Available Sarvers
[~ asosearch | manuat |
| Name | Device Name | IP Address |
AERO [PlateSetter, ... 10.10.83.9
AZU [7o40] 10.10.82.18
ASAMA, [p330] 10.10.82.14

o ——
e —

2. If no EX7750 servers were found, click the Manual tab to search by DNS name or IP
address. Click Add to add the server to the Available Servers list.

8 g Available Servers

[ MioSearch |- mtammt]

Enter the Server DNS name or P
address exactly as configured on the Server.

10.10.10.101

G o)
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Fonts

The Fonts installer on the User Software CD includes screen and printer fonts that
correspond to the 136 built-in PostScript printer fonts on the EX7750. The Font
installer copies both types of fonts to the System Folder: Fonts folder on your hard
disk. To be available to applications, the screen fonts must remain in the

System Folder: Fonts folder. You can copy the printer fonts to a folder of your choice.

Note: In the SystemFolder:Fonts folder, when displayed by Kind, screen fonts appear
as type “Font Suitcase” and PostScript printer fonts appear as type “PostScript font.”

Note: To back up installed fonts, see the Configuration Guide.

TO INSTALL SCREEN AND PRINTER FONTS

1.

On the User Software CD, double-click the Fonts icon to start the Fonts installer.

NoTEe: Access the Fonts icon from the OS 9 folder on the User Software CD.

Click Install and restart your computer.
By default, the fonts are installed to the System Folder: Fonts folder on your hard disk.

If you have any applications open, you must quit and restart them before the newly
installed screen fonts are available.
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Installing color files from the User Software CD

You can copy additional color files from the User Software CD to your hard disk.
Many of the files are PostScript files you can download and print using
Fiery Downloader.

The User Software CD contains the following color files:

ICC profiles Install the ICC profiles into the ColorSync Profiles folder inside
(inside the the System Folder.

ColorSync
folder)

Mac Color Files  CMYK Color Reference.ps, an 11-page, letter-size PostScript file
folder to use for reference when defining CMYK colors in applications.

PANTONE Book.ps, a 19-page, letter-size PostScript file that
indicates the closest equivalent of PANTONE coated colors that
the EX7750 and your particular printer model can produce. The
method used to print the PANTONE Book.ps file differs
depending on the Spot Color Matching setting. For more
information, see the Printing Guide and the Color Guide.

RGB page 01, a file you can print from Microsoft Word 97 or
later to view available RGB colors.

RGB page 02, a file you can print from PowerPoint 6.0 or later

to view available RGB colors.

Calibration These files are provided for expert users and should not be used
folder for day-to-day calibration.

(inside Mac

Color Files

folder\English

folder)
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Loading ICC printer profiles

The ICC profiles are used with ColorWise Pro Tools and applications that support
ICC standards.

These instructions assume that you have already installed the ICC profiles included on
the User Software CD inside the ColorSync folder. For more information, see
“Installing color files from the User Software CD” on page 2-23.

Note: The internal name of an ICC profile may vary slightly from its file name.

The following procedure describes installing the ICC profiles with ColorSync 4.0.
For more information about ColorSync, see the documentation for your application.

To SET THE COLORSYNC SYSTEM PROFILE

1.

2.

Choose Control Panels:ColorSync from the Apple Menu.

Select EFIRGB ICC vif from the System Profile list.

0="—————-=0OlorSyiir=———"—8

Profiles CMMs \ / About

System Profile: | EFIRGB v =)
RGB Default: [ Generic RGB Profile =]
CMYK Default: [ Generic CMYK Profile B

When selected as the ColorSync system profile, EFIRGB ICC v1f sets the optimal
source color space for printing to the EX7750. The color space set by the

EFIRGB ICC vl1f profile is the same as that set by the EFIRGB setting of the RGB
Source Profile print option.

Note: The RGB Source Profile print option setting overrides the ColorSync system
profile setting.

Close the ColorSync dialog box.

For more information about ICC printer profiles, see your Photoshop documentation.
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Loading the monitor settings file

The EFIRGB ICC monitor settings file can be used in Photoshop or other applications
that support ICC profiles to define a source color space for printing to the EX7750.

TO LOAD THE MONITOR SETTINGS FILE IN PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu, and choose RGB Setup from the Color
Settings submenu.

3. In the RGB Setup dialog box, click Load.

4. Browse to the System Folder:Preferences:ColorSync Profiles folder, select the EFIRGB
ICC file, and then click Open.

RGB Setup

RGB: | EFIRGB v 11 ¥ I
Gamma: Cancel
White Point:| 5000°K (D50) = Load...

Primaries: | SMPTE-C (CCIR601-1) | 3]

Save...

O
3
B
<
o
£

Monitor: Calibrated Profile

[4 Display Using Monitor Compensation

Note: If you are using ColorSync 2.5, the ColorSync profile is located in the System
Folder: ColorSync Profiles folder.

The EFIRGB v1f file appears as the selection.

5. Click OK.



2-26 | Installing User Software on a Mac 0S Computer

Loading the ICC printer device profile

The ICC printer profile enables RGB-to-CMYK conversions that are specific to the
kind of printer you are using.

To LOAD THE ICC PRINTER DEVICE PROFILE IN PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose CMYK Setup from the Color
Settings submenu.

3. In the CMYK Setup dialog box, choose ICC as the CMYK color model.

4. Select the profile that corresponds to the EX7750 from the Profile menu.

= (MYKSetup
CMYK Model: () Built-in @ 1CC () Tables
ICC Options [m
Prnﬁle:[ Aero %
Load...
Engine:| Built-in =
Save...
Intent:[ Perceptual (Images) i]
[ Black Point Compensation [ Preview

5. Click OK.
For more information about ICC profiles, see your Photoshop documentation.

Loading monitor settings and the ICC device profile in Photoshop 6.x/7.x

In Photoshop 6.x and 7.x, you can load the monitor settings file and the ICC profile at
the same time.
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TO LOAD THE MONITOR SETTINGS FILE AND THE ICC PRINTER
DEVICE PROFILE IN PHOTOSHOP 6.X/7.X

Jury

. Start Photoshop.

2. Choose Color Settings from the Edit menu and then choose Advanced Mode.

3. Choose EFI RGB from the RGB menu.

4. Choose the profile that corresponds to the EX7750 from the CMYK menu.

Color Settings

Settings: [(ustnm

[»]

[ Advanced Mode

Cancel
Working Spaces

RaE: [[EFIRGE viT

Load...

cmivk: [Aero 12 MaxPPMK v2F

Gray: [(Gray Gamma 22

o o) e e

Spot: [ Dot Gain 20% [ Preview

Color Management Policies

Gray: [[off

II

4

Profil Mismatches: [ ask When Opening Ask when Pasting
Missing Profiles sk When Opening

Conversion Options

Engine: [_adobe (ACE) B
Intent: [ Relative Colorimetric B
[ Use Black Point Compensation [ Use Dither {5-bit /channel images)

Advanced Controls
[ besaturate Monitor Colors By-
[ Blend R&E Colors Using Gamma:

Description

&

5. Click OK.

For more information, see your Photoshop documentation.
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Chapter 3:
Downloading

Installers with
WebTools

3-1 | Setting up WebTools

WebTools allow you to manage your EX7750 remotely from the Internet or from your

company’s intranet.
For more information about using WebTools, see the Printing Guide.

Setting up WebTools

To enable network users to access and use WebTools, you must set specific EX7750
options in Network Setup and Printer Setup. You also must prepare each user’s
computer to communicate with the EX7750 over the Internet or intranet.

For more information about Network Setup and Printer Setup, see the

Configuration Guide.

TO SET UP CLIENT WORKSTATIONS TO USE WEBTOOLS

1.

2.

Enable TCP/IP networking.
Make sure the workstation has a valid, unique IP address.

Make sure a supported Internet browser is installed on the computer.

For more information about supported browsers, see the Quick Start Guide.

Make sure Java is enabled in your Internet browser.

For more information about setting up the EX7750 and the network, see the
Configuration Guide.
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Using the WebTools Installer

The Installer WebTool allows you to download installers for printer drivers directly
from the EX7750 to your computer.

TO DOWNLOAD PRINTER DRIVERS WITH THE INSTALLER WEBTOOL

1. Start your Internet or intranet browser and enter the DNS name or IP address of
the EX7750.

2. Click the WebTools button.

3. Select a login level, enter a password if required, and click OK.

No password is required to log in as Guest. If the administrator has configured Guest
access, any user has full access to the Installer WebTool while logged in as Guest.

4. Click Installer.

A Fiery WehTools: Microsoft Internet Explorer [(A=1_3

Electronics ;,Z, WebTO O 1 S

renimaging
Macintosh
Status
WebLink
WehDownloader

WebSetup
Installer

Windows

2] WebTools Available & Internct

5. Under the name of your operating system, click the name of the item you want
to install.

6. For installation of user software, follow the on-screen instructions.
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7.

10.

For installation of printer drivers, continue with the following instructions.
A dialog box appears, prompting you to save the file to the location you choose.

For Windows computers, a dialog box appears, offering you the choice of running the
program across the Internet or intranet or saving it to disk.

For Mac OS computers, a folder named Printer Driver is downloaded to the desktop
in a BinHex-encoded, compressed format. If your Internet browser is equipped with
an expander utility, such as Stufflt Expander, the folder decodes and decompresses
automatically.

For Windows computers, browse to the location where you want to save the
Prntdrve.exe and click Save.

For Mac 0S computers, if the Printer Driver folder did not automatically decode and
decompress, start the utility that performs that function.

For Windows computers, double-click the Prntdrve.exe file, browse to the location
where you want to install the folder, and click Next.

The folder is installed to the location you specified.

Install the appropriate printer driver for your operating system.

For instructions on installing

the printer driver for See
Windows 2000/XP “Installing the PostScript or PCL printer driver for
Windows 2000/XP” on page 1-2
Mac OS 9 and Mac OS X “Setting up Mac OS 9 printer drivers and printer
Classic mode description files” on page 2-2
Mac OS X Native mode “Setting up Mac OS X v10.2 printer drivers and

printer description files” on page 2-5
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Chapter 4:
Troubleshooting

4-1 | On a Windows computer

This chapter provides troubleshooting tips.

On a Windows computer

Setting up printing on Windows 2000/XP computers

If you have problems installing the EX7750 with Windows 2000/XP, try installing
another PostScript printer (such as the Apple LaserWriter I1g), and then install the
EX7750. Installing another printer ensures that all files are properly installed and
available. For instructions, see your Windows documentation.

For information about problems you may encounter using the PostScript Printer
Driver for Windows 2000/XP, see the Adobe README file (readme) included on the
User Software CD. For Windows 2000/XP, see your Windows documentation.

Problems with the Fiery utilities on Windows computers
If you are experiencing problems with connections for the Fiery utilities, try
the following:

Make sure the TCP/IP networking protocol is enabled.

Make sure the connection is configured correctly for your site.

To check the current configuration, start a Fiery utility and choose Open from the File
menu. Select the EX7750 and click Modify to see current settings. If the settings are
incorrect, you can change them in this dialog box.
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On a Mac 0S computer

Setting up the EX7750 in the Mac 0S 9 Chooser

If Auto-setup does not work and you are prompted to select the printer description file,
select the appropriate EX7750 file on your hard disk: System Folder: Extensions:
Printer Descriptions folder, “ColorPASS-Z7000 Ver 3.0”.

Installing screen fonts
If you experience problems installing the PostScript screen fonts from the User
Software CD to the System Folder: Fonts folder, try the following:

1. Quit all applications and close all windows.

2. Create a new folder and name it “Uninstalled Fonts.”
This folder must be located outside of the System Folder.

3. Move fonts you are not using from the System Folder:Fonts folder to the Uninstalled
Fonts folder.

4. Install the fonts from the User Software CD to a folder called CD fonts. Copy the fonts
to the System Folder:Fonts folder.

5. Create aliases to the System Folder:Fonts folder and the Uninstalled Fonts folder.
6. Place both aliases on your desktop.

7. When necessary, use the aliases to open both folders and move fonts between them.

If you have any applications running, you must quit and restart them in order to view
and use the newly installed fonts.

Or, you can try combining fonts from multiple suitcases into a single suitcase.

Setting up the EX7750 in the Mac 0S X Print Center

If Auto-setup does not work and you are prompted to select the printer description file,
select the appropriate EX7750 file in your hard disk: System: Library: Printers: PPDs:
Contents: Resources:language folder (for example, en.lproj),

“ColorPASS-Z7000 Ver 3.0”.
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printer setup 2-5
Mac OS X
setting up server in 4-2
Mac OS
fonts 2-22
Installer WebTool 2-1
installing color files 2-23
installing Fiery utdilities 2-1, 2-11
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installing software 2-11

troubleshooting 4-2

uninstalling software 2-13
monitor settings file, Mac OS 2-25

N

NetWare client setup
Windows 2000/XP 1-13

0
Oemsetup.inf file 1-3

P
PANTONE Book.ps 2-23
PANTONE.ps 1-34
PDF files xiii
Photoshop 5.x
loading the copier device profile
(Mac OS) 2-26
loading the ICC copier device profile
(Windows) 1-37
loading the ICC DC device profile
(Windows) 1-37
loading the ICC monitor settings file
(Mac OS) 2-25

loading the RGB working space profile

(Windows) 1-36
Photoshop 6.x/7.x
loading the ICC copier device profile
(Windows) 1-38
loading the ICC monitor settings file
(Windows) 1-38

loading the monitor settings and the ICC

device profile (Mac OS) 2-26
PostScript
printing from Mac OS 2-2 to 2-22
printing from Windows 2000/XP 1-1
screen fonts xiii

PostScript Printer Description file, see PPD

PostScript printer driver
for Mac OS 2-2
installing using WebTools 3-2 to 3-3
Windows 2000/XP 1-2

PowerPoint, RGB color reference file 2-23
PPD
copying files for Windows
applications 1-39
overview xiii
selecting the PPD in the Chooser 4-2
selecting the PPD in the Print
Center 4-2
Windows 2000/XP 1-4
Print Center
selecting the server in 2-6
setting up server in Mac OS X 4-2
Print Setup Utility
selecting the server in 2-6
Printer Driver, installable options
Windows 2000/XP 1-5
printer drivers
deleting 1-23
downloading installers 3-2
Printer Info Options
specifying, from Mac OS X printer
driver 2-10
printer setup
Mac OS 9 2-2
Mac OS v10.2 2-5
printing
Windows 2000/XP 1-8
Prntdrve.exe file 3-3

R

RGB page 01 2-23
RGB page 02 2-23
Rgb_01.doc 1-34

Rgb_02.ppt 1-34

S
screen fonts 2-22, 4-2
SMB printing setup

on Windows 2000/XP 1-15, 1-16
specifications, color server xii
Stand21.ps (Windows) 1-34
Stand34.ps (Windows) 1-34
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thinnet cable xii
troubleshooting
Mac OS computers 4-2
Windows computers 4-1

U
Uninstalled Fonts folder 4-2
uninstalling
Mac OS software 2-13
unshielded twisted pair (UTP) cable xii
User Software CD
contents (Mac OS) 2-2
contents (Windows) 1-19
installing from, for Mac OS 2-2, 2-23
troubleshooting fonts 4-2

w
WebDownloader WebTool, see WebTools
WebTools
Installer xv, 3-2 to 3-3
setting up 3-1
Status xv
WebDownloader xv
WebLink xv
WebTools Installer
downloading printer drivers 3-2
Windows
copying color files 1-34
installing Fiery utilities 1-19
troubleshooting 4-1
Windows Color Files folder 1-34
Windows 2000/XP
IPX 1-13
PostScript printer driver 1-2
printing requirements 1-8
setting up PostScript printing 1-1
troubleshooting 4-1
Windows NT 4.0
troubleshooting 4-1
WINS Name Server 1-16
Word, RGB color reference file 2-23
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